TCP/IP PLC Simulator User Guide
IGSS Version 10.0
The information provided in this documentation contains general descriptions and/or technical characteristics of the performance of the products contained therein. The documentation is not intended as a substitute for and is not to be used for determining suitability or reliability of these products for specific user applications. It is the duty of any such user or integrator to perform the appropriate and complete risk analysis, evaluation and testing of the products with respect to the relevant specific application of use thereof.

Neither Schneider Electric nor any of its affiliates or subsidiaries shall be responsible or liable for misuse of the information contained herein. If you have any suggestions for improvements or amendments or have found errors in this publication, please notify us.

No part of this document may be reproduced in any form or by any means, electronic or mechanical, including photocopying, without express written permission of Schneider Electric.

All pertinent state, regional and local safety regulations must be observed when installing and using this product. For reasons of safety and to help ensure compliance with documented system data, only the manufacturer should perform repairs to components.

Failure to use Schneider Electric software or approved software with our hardware products may result in injury, harm or improper operating results.

Failure to observe this information can result in injury or equipment damage.

©2004, 2011 Schneider Electric, All rights reserved.
# Table of Contents

## Chapter 1: Introduction and Setup

1.1 Introducing the TCP/IP PLC Simulator .......................................................... 1  
1.2 Activating the Generic TCP/IP driver ............................................................. 2  
1.3 Auto-starting the PLC Simulator .................................................................... 3  

## Chapter 2: Functionality

2.1 DBInput ............................................................................................................ 5  
2.2 Sending an array ............................................................................................. 5  
2.3 Sending a number ........................................................................................... 6  
2.4 Sending a string ............................................................................................. 8  
2.5 Scan / event .................................................................................................... 8  
2.6 OnTop ............................................................................................................. 9  

## Chapter 3: Reference and Lookup

3.1 Conventions in this Manual ........................................................................... 10  
3.2 Getting Help in IGSS ..................................................................................... 10  
3.3 Version Information (IGSS Help System) ......................................................... 12  

## Chapter 4: Glossary

.......................................................................................................................... 13
Chapter 1: Introduction and Setup

1.1 Introducing the TCP/IP PLC Simulator

TCP/IP PLC Simulator is a software PLC which can be used to simulate a real PLC and test configurations.

The soft PLC works together with the Generic TCP/IP driver - ID 34.

The soft PLC has the following features:

- can send and receive values, arrays and strings to and from IGSS
- can send and receive alarm bits
- supports four different data modes - BYTE, WORD, DWORD and FLOAT
- supports up to 8 nodes
- simulates a real PLC allowing you to get real driver alarms

The soft PLC looks like this. In this case, the user has double-clicked on Word number 0 to send a value to IGSS.

For a live example using TCP/IP PLC Simulator, watch this video:

[IGSS OPC Client and Server](#)
1.2 Activating the Generic TCP/IP driver

Before you can make use of the IGSS Soft PLC, you must activate the Generic TCP/IP driver, ID 34.

1. Open the System Configuration module.
2. Select the station from which you will be using the soft PLC.
3. Click the Add Driver icon in the toolbar or right-click the station and select New Driver.
4. Click the header of the ID column to sort by ID. Scroll down to find ID 34.
5. Double-click the driver as shown below.

![Select Communication Driver]

6. Click the + sign beside the driver name and select the interface icon named 7TCP. Right-click and select New Node.
7. By default, a node is set up to be running on the local host. This can be changed to a remote IP address, if required.

8. If required, you can add as many as 8 nodes. The soft PLC supports up to 8 nodes.

9. The driver is now activated and ready to run with IGSS Soft PLC. Make sure that Run Simulated is not selected on the Data Collection tab.

10. In the File menu, select Save and Exit.

11. Continue with the topic: Auto-starting the IGSS Soft PLC.htm

1.3 Auto-starting the PLC Simulator

When you are using the PLC Simulator, you may want to auto-start it every time you start the IGSS configuration. Do the following:

1. Open Windows Explorer.

2. Navigate to the folder containing the current IGSS configuration.

3. Create a subfolder named Startup.
4. In this folder, create a shortcut to the PLC Simulator executable:

[IGSS InstallPath]\Gss\7TTCPMON.exe

5. Assign a name to the shortcut, for example, **Soft PLC**.

IGSS will automatically activate all shortcuts located in the **Startup** folder when you start this configuration.

If you need to manually start the PLC Simulator, go to the **Runtime and Diagnostics** Tab in the IGSS Master and click the **TCP/IP Simulator** button.
Chapter 2: Functionality

2.1 DBInput

In DBInput you can either choose hexadecimal or decimal as the basis. The type can either be a number, an array or a string.

2.2 Sending an array

1. Make a test object in IGSS, for example a table object with three values, "Address type" WORD and offset 1. Choose 7T TCP as driver on the Edit Mapping tab.
2. Double click element number 2 in TCP/IP PLC Simulator and enter the value "1". Click **Ok NoSend**.

3. Double-click element number 3, enter "2" and **Ok NoSend**.

4. Double-click element number 4, enter "3" and **Ok NoSend**. Choose element number 2, choose "Array" and enter "3". Click **Ok Send**. Your table object should now show 1, 2 and 3.

### 2.3 Sending a number

1. Make a test object in IGSS, for example of the type Analog, and choose **7TTC** as driver on the **Edit Mapping** tab.

2. Choose **Data type** Word and **Offset** 0. As default, the values in TCP/IP PLC Simulator are sent to the object and hence there is no need to scan it.
3. Double click index 0 in TCP/IP PLC Simulator. A dialogue, **DBInput**, appears. Set **DB value** to 1 and click **OK Send**. Your test object should show 1.
2.4 Sending a string

1. Make a new test object in IGSS of the type "String" with Data type WORD and Offset 2.
2. Choose 7TTCP as driver on the Edit Mapping tab.

3. Double-click element number 3 in TCP/IP PLC Simulator, choose String as type and enter "Test". Click Ok Send. Your object in IGSS should show "Test".

2.5 Scan / event

As default TCP/IP PLC Simulator is event driven and the objects do not need to be scanned. If you want to test the scanning of objects, this must first be chosen in IGSS.

1. Right-click an object, click the Data Management Definitions tab. For example, choose a Scan interval of 2000 msec.
2. In TCP/IP PLC Simulator, double-click an element belonging to the object, which should be scanned. Choose a type and enter a value. Click "Ok NoSend" to send it to TCP/IP PLC Simulator database. IGSS will scan the object for changes and copy the value to the object.

2.6 OnTop

This option can be used to maintain the Tcpmon window **On Top** of IGSS while testing.
Chapter 3: Reference and Lookup

3.1 Conventions in this Manual

The following typographical conventions are used:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>User interface</td>
<td>When referring to labels and names in the user interface.</td>
<td>The Data Management tab.</td>
</tr>
<tr>
<td>User input</td>
<td>When the user has to type specific data in IGSS</td>
<td>Type the following description:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Incoming flow in Tank 2</td>
</tr>
<tr>
<td>Module name</td>
<td>When referring to a module in IGSS</td>
<td>Open the Definition module.</td>
</tr>
<tr>
<td>Note</td>
<td>A note emphasizes or supplements important points of the main text.</td>
<td>By default, the timestamp is in universal time format, UTC(^\text{1}). This can be changed in the Driver Log Filters dialog box.</td>
</tr>
<tr>
<td>Tip</td>
<td>A tip suggests alternative methods that may not be obvious in the user interface. A tip also helps the user in working more effectively with IGSS. A tip is not essential to the basic understanding of the text.</td>
<td>Alternative to this simple find function, you can also filter on text in the messages in Driver Log Filters dialog box.</td>
</tr>
<tr>
<td>Warning</td>
<td>A warning is an important note that is essential for the completion of a task. In some cases, disregarding a warning may result in undesirable functionality or loss of data.</td>
<td>If you disregard the System alarm, you may risk loss of data in the LOG and BCL files.</td>
</tr>
</tbody>
</table>

3.2 Getting Help in IGSS

IGSS comes with a comprehensive help system designed to help both system designers and operators to get started with IGSS as quickly as possible.

Documentation overview

The IGSS documentation includes the following items:

---

\(^{1}\)Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.
<table>
<thead>
<tr>
<th>Documentation item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>An introduction to IGSS and its most fundamental terms and features. Getting Started is intended to get you up and running as fast as possible. The manual provides a system and architecture overview followed by a number of real-life use cases you can go through before building your first real IGSS project. The manual is available in Adobe Acrobat format (.pdf).</td>
</tr>
<tr>
<td>Module help</td>
<td>For each module there is a help file with the same name as the module itself, for example, Def.chm for the Definition module. The help file is invoked by clicking the 📚 in the upper right corner of the module. The Table of Contents will then allow you to browse through the topics.</td>
</tr>
<tr>
<td>Form and Dialog help</td>
<td>For each Form or dialog there is a help topic with the following standard information:</td>
</tr>
<tr>
<td></td>
<td>• Overview</td>
</tr>
<tr>
<td></td>
<td>• Preconditions</td>
</tr>
<tr>
<td></td>
<td>• Where do I find it?</td>
</tr>
<tr>
<td></td>
<td>• Field help</td>
</tr>
<tr>
<td></td>
<td>Form help is invoked by clicking the help button 📚 in the upper right hand corner of the dialog box or located in the Table of Contents of the individual help file.</td>
</tr>
<tr>
<td>Thematic help</td>
<td>IGSS also provides thematic help. When there is a special theme that requires special attention from the user, a dedicated help file is provided. Examples include &quot;Driver-Specific Help&quot; and &quot;Database Administration Help&quot;.</td>
</tr>
</tbody>
</table>

**Where are the help files located?**

The IGSS help files are located in the appropriate language folder in the installation path of IGSS, by default C:\Program Files\Schneider Electric\IGSS32\V10.0. The help files are available in English at release time.

The paths to the help files are:

<table>
<thead>
<tr>
<th>Language</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>[IGSS InstallPath]\ENG</td>
</tr>
<tr>
<td>Danish</td>
<td>[IGSS InstallPath]\DAN</td>
</tr>
<tr>
<td>German</td>
<td>[IGSS InstallPath]\DEU</td>
</tr>
</tbody>
</table>

**Translated help files**
Selected help files have been translated into Danish and German. If you require help files in your language, please contact 7-Technologies A/S.

**Help updates**
The help files are continuously updated and improved. Check regularly with the IGSS Update in the IGSS Master.

### 3.3 Version Information (IGSS Help System)

© 7-Technologies A/S, IGSS Version 10.0

The IGSS help files are based on software build number 10305 (initial release)

**English help files**

To update the help files, click the *Update IGSS Software* button on the *Information and Support* tab in the *IGSS Master*. There must be a connection from the PC to the Internet. Every time *IGSS Update* is run, IGSS help files as well as IGSS system files will automatically be updated on the PC from the web server at 7-Technologies A/S.

You select the languages you want to update in the *Tools* menu of the *IGSS Update* form.

If you are not able to update the IGSS system directly via the Internet, the alternative is to download the updates from the 7-Technologies A/S website as zip files. These can then be transferred onto a CD or USB memory stick, which is then the medium used to update on site.

After updating your IGSS installation, the build numbers in various IGSS modules may change to a higher number. This signifies that the module in question has been updated with newer files. Build numbers consist of four digits, where the first digit represents the year and the last three represent the day number in the year in question. The build number can be seen in the *About* dialog box which can be activated from the *Help* menu.

An example:

**Build number = 10305**
12 = the year 2012  
305 = The 305th day of the year
Chapter 4: Glossary

A

Application menu
The Application menu is the first ribbon in the IGSS Master module. Click the icon to drop down the menu. The menu contains items that were typically found in the File menu in previous versions of IGSS. In most modules, an "Options" item allows the user to define global module settings. The Application menu was introduced in the Microsoft Office 2010 package. It replaces the Application button (nicknamed Doughnut) which was introduced in IGSS V7 and V8.

D

descriptor
A descriptor is the graphical display of an object. IGSS includes many types of descriptors including: - Built-in standard symbols - Animated symbols (Symbol Factory library) - Graphics and animation - Drawing symbols - Windows controls - ActiveX controls An IGSS object can be represented with different descriptors on different diagrams.

Q

Quick Access Bar
You can customize the Quick Access Bar to include the functions you use most frequently. Simply drag the relevant function from the ribbon to the Quick Access Bar.

R

Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the well-known toolbars in applications. The Ribbon provides quick access to the most commonly used functions in the application. The Ribbon is divided into logical groups (the tabs) and each tab is divided into sections (the blocks in the tab). The Ribbon is context-sensitive which means that only relevant functions are accessible dependent on the current user action.

S

SCADA
Supervisory Control & Data Acquisition

U

UTC
Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating time in most parts of the world. IGSS uses this time format internally in the database. You can switch between UTC and local time by enabling or disabling the "UTC" field in various dialog boxes in the system.